Using Microsoft Access Forms & Reports

Lﬂ Using Microsoft Access

Forms

Although information in a database can be entered and edited directly in a table, most
people find it simpler to use a form. We use forms all the time in everyday life as a way
of recording information so forms are familiar to us. The Form design tools in Access are
very flexible and allow you to customise a form with many features to make it easy to
use. Forms can be created in a few different ways.
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Use an Auto form to create a form based on a standard layout.

Use the Form Wizard.

Use one of the above methods and then modify the form in Design View.
Create a form completely from scratch using the Design View tools.

As you become more and more familiar with working with Forms in Access you may find yourself
using the latter methods more and more. To begin with though, it is best to use the Auto forms and
Form Wizards until you are more comfortable with designing forms.

Using Auto forms

Auto forms allow you to create a form quickly based on a standard layout. In the first exercises, you
actually used an auto form when you used a form for data entry. There are several auto form layouts
to choose from and we will try out three of them in the following exercises.
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Using Microsoft Access Forms & Reports

Exercise 1. Creating a Datasheet Auto Form

. . L Upen B Uesign |23 Me
1) Make sure your Student List database is open. e |[& &
2) Select the Forms section from the Database Window. 3 e |2
3) Click the New button == at the top of the Database Window. B Queries

4) When the New Form dialog appears, click on the list at the bottom as shown = Forms
below. A list of all your tables and queries appears since forms can be based | @ repors
on either.

5) Select your STUDENTS table from the list (it’s easy to tell which one’s a table because we
named tables in uppercase and queries in lowercase).

i 2 X

Design View

z Form ‘Wizard
S AutoForm: Columnar
: AutoForm: Tabular

This wizard automatically At nc ety

AutoForm: PivotTable
creates a datasheet form, AutoFarm: PivatChart

Chart Wizard
PivotTable Wizard

Choose the table or gquery where I i
the object's data comes from: L

parameter: students by last namg
parameter: students by suburb
parameter: students marks betwd
student listing with age

student marks
STUDENTS

summary: student marks %
test query

6) From the list of options at the top of the dialog, select AutoForm: Datasheet.
7) Click OK to create the form.

f

ESISTUDENTS = Bex
Student Number | Last [Name | First Name | Dateof Bith | Address | Suburb
id 1 Rabhins Mark 17-06-89 4 Kensington Ave Dianella
| 2| Stevens Sarah 10-04-89 24 Browne Ave Yokine
| 3| Andrews Claire 01-11-89322 Walter Rd Morley
| 4 McKay Tim 02-08-89 /54 Coode St Dianella
Rl Datmrenm Drkmrt T2 N2 200N Flimdars S Woaldima

The end result is a form that looks and acts the same as a table. It may not seem very useful to have a
form that’s the same as a table but it can be very useful for subforms as you will see later on.
Sometimes it is handy to have a list inside a form. Since a table can’t be placed inside a form,
another form that looks like a table can be used instead.

8) Close the form.
9) When you are prompted to save the form, click Yes.

[carie 2 x

Form Mame: |
|STUDENTS: Datasheet |

il

¥
g

10) Enter STUDENTS: Datasheet as the form name and click OK.
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Exercise 2. Creating a Tabular Auto form
1) Click the New button == at the top of the Database Window.

r([.'f-i'l'fftllm‘ P2
Design View
Z Form Wizard
T ,1 | AutoForm: Columnar
—r—r— AutoForm;:. Tabular

AutoForm: Datasheet
AutoForm: PivotTable
AutoForm: PivotChart
Chart Wizard
PivotTable Wizard

This wizard automatically
creates a tabular form.

Choose the table or query where : ]
the object's data comes from: |STUDEN'I'S b |

[ LOK | [ cancel |

2) When the New Form dialog appears, select the options shown above (STUDENTS as the table and
AutoForm: Tabular as the type of form).
3) Click OK to create the form.

lE=1STUneNTs |
lumber Last Man First Mar of Bith Address Subub Po 51 Phone  Gender Mark Comnment [#]
P\ | [Fobbins|Mark |[-06-85] [4 Kensir| [Dianeli] [50][w[08] 337|[Male || 78] =
[ 7|[Stevens|[Sarsh |[104-85|[24 Brow|[Yokine | [60][][[08) 524| [Female || 62|[New student
[ 3|[Andrewd[Claire | [-11-85|[322 wa| [Morley | [60][w][[08) 527] [Female || 58||

4) Close the form.
5) When you are prompted to save the form, click Yes.
6) Enter STUDENTS: Tabular as the form name and click OK.

A tabular form can be used in the same was as a table, but it can be formatted and customised a lot
more than a table. This form could be neatened up in Design View as you will see later.
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Using Microsoft Access

Exercise 3.

Creating a Columnar Auto Form

Forms & Reports

This is the type of form that was created in the first section when you used a form for data entry.
1) Click the New button == at the top of the Database Window.

erorm ? X
Design View
Z Form Wizard
—— ‘AutoForm: Columnar
A AutoForm: Tabular
Autof: : Datasheet
This wizard automatically :ﬂtgFEm' Pi?'oat;ai.lae
creates a columnar form. AutoForm: PivotChart
Chart Wizard
PivotTable Wizard
Choose the table or query where : ]
the object's data comes from: |STUDEN'I'S b |
[ @x [ cancel |

2) When the New Form dialog appears, select the options shown above (STUDENTS as the table and
AutoForm: Tabular as the type of form).

3) Click OK to create the form.

Unlike the other two forms, this one only shows one record at a time. Most people find this makes it

easier to work with records.

- 0O x

> Student Numnber |7i! Caomment

Last Name @

First Name @

DatecfBith [ 17-06-89

Address ﬁensington fve

Suburb Dianella |

Postcode 6059

State W

Phere

T T —

Mark 7
Record: i R £ LEE of 12

4) Close the form.

5) When you are prompted to save the form, click Yes.
6) Enter STUDENTS: Columnar as the form name and click OK.
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Using Microsoft Access Forms & Reports

Custom Forms

Using the Form Wizard and form Design View allow you to have a lot more control over how your
form looks and functions. These methods allow you to select fields from more than one table/query
as well as giving you a lot of choice about how the form will appear.

Exercise 4. Using a Form Wizard

1) Click the New button =lt=» at the top of the Database Window.
2) Choose Form Wizard from the list of options. Choose STUDENTS for the table.

[(Nevirorm ?2 X

- m v d
h’/‘ AutoForm: Columnar
= AutoForm: Tabular

AutoForm: Datasheet
AutoForm: PivotTable
AutoForm: PivotChart
Chart Wizard
PivotTable Wizard

Create a new form without
using a wizard.

Choose the table or query where

| A
the object's data comes from: EILENTE i |

3) Click OK to begin the wizard.

In the first step of the wizard, you are asked to specify which fields will be used in the form.

4) Click the 22 button to select all of the fields for use in the form. All of the fields will now be
listed on the right side.

5) Double-click on Student Number to move it back over to the left, since we won’t need to have
that displayed in our form.

[Eorm\Wizard)
Which fields do you want on your form?
% N ‘fou can choose from more than one table or guery.
Tables/Queries
Table: STUDENTS a0
Available Fields: Selected Fields:
> A
— ' First Name ,i‘gj
o Date of Birth
— Address
—y  Suburb
é Postcode
< | State E
Phone | v |
Cancel . < Bach Mext = | Einish

6) Click Next to move to the next step of the wizard.
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[Formwzacd ]

What layout would you like for your form?

o

(T Tabular
o Datasheet
(O Justified
() PivotTable
(7 PivotChart

i

Cancel <gock | mext> | s

7) Leave Columnar selected for the Form Layout and click Next.

[Formwzacd ]

What style would you like?

Blends
Blueprint
Expedition
Industrial
International
Ricepaper
SandStone
Standard
Stone

Label

<gock | mext> | s

8) Click on each of the different form styles to see the preview for each one.
9) Select a style you like and click Next.

© Steve O’Neil 2005 Page 6 Of 16 http://www.oneil.com.au/pc/




Using Microsoft Access

(Form Wizard

What title do you want for your form?

|Student Entry Form

That's all the information the wizard needs to aeate your
form.

Do you want to open the form or modify the form's design?

™ Dpen the form to view or enter information,

(0 Modify the form's design.

[ Display Help on working with the form?

Cancel | < Back Mext > Einish

Forms & Reports

The last step in the wizard asks you to specify a name for the form. When you click Finish, the form

is automatically saved with that name.

10) Type Student Entry Form for the form title and click Finish.

rﬁ&t‘fﬁﬂﬁ(ﬂmcﬂﬁm

4 Last Name

State

|

First Name Mark

Date of Birth
Address
Suburb
Postcode

i

Phone (08) 9375 1234

Gender
Hark

Record: E' A I 1 E'EE of 1%

Comment

11) Close the Form. There is no need to save it since it was saved at the end of the wizard.
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Using Microsoft Access Forms & Reports

Reports

Reports are used in a database to present information in a neat and organised format that is ready for
printing. When a report is opened in Access, it is opened in Print preview for this reason. Creating a

report is very similar to creating a form and like a form, can be done using any of the following
methods:

e Use an Auto report to create a form based on a standard layout.

e Use the Report Wizard.

e Use one of the above methods and then modify the report in Design View.

e Create a report completely from scratch using the Design View tools.
Exercise 5. Creating a Tabular Auto Report

1) Make sure you are in the forms section of the Database Window.
2) Click the New @l=w putton at the top of the Database Window.

fiew Report 2 X
o .
==z4 5 c .
‘AutoReport: Tabular
Chart Wizard
This wizard automatically L ;;‘; -‘-,f-iI:;:!d
crestes a tabular report.
Choose the table or query where 7 o]
the object's data comes from: EILENTE i |
| LOK | | Cancel |

3) Select AutoReport: Tabular and make sure the STUDENTS table is selected as the source.
4) Click OK to create the report. The report will appear in Print Preview ready for printing.

STUDENTS

t Number Last Name First Name 2 of Birth Address Suburh Postc State Phone Gender
1 Robbinz Mark 1706-8% 4 Kensington & Dianella 8058 WA (08) 9375 1234 Male
2 Stewens Sarah S 10-404-8% 24 Browne Ave “Yokine 8080 VWA (08) 9245 8127 Female
3 Andreve Clairs .~ 01-11-88 322 Walter Rd  Morley §038 WA (08)9%273 1937 Female
4 McKay Tim 02-08-89 54 Coode 5t Dianslla 6059 WA (08) 9375 5610 Mals

5) Close the report. When prompted, save the report as Student Report: Tabular.
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Exercise 6. Creating a Columnar Auto Report
1) Click the New @M= putton at the top of the Database Window.

(ew Report ? X

Design View
4 Report Wizard
e ‘AutoReport: Columnar

This wizard automatically
creates a columnar report.

Choose the table or query where : =1
the object's data comes from: |STUDEN'I'S b |

[ am [ cancel

2) Select AutoReport: Tabular and make sure the STUDENTS table is selected as the source.
3) Click OK to create the report. The report will appear in Print Preview ready for printing.

STUDENTS
Student Number | 1|

Last Name [Roteins |
First Name [Mark |
Date of Birth 17-08-89
Address [ Kensington &ve |
Suburb [pianeia |
Postcode

State

Phone e} 9375 1234 |
Gender [ake |
Mark | 72|
Comment |

Student Number 2

Last Name [tevens |

4) Close the report. When prompted, save the report as Student Report: Columnar.
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Exercise 7. Using a Report Wizard
1) From the Database Window, click the option that says Create report by using wizard.

[Report Wizard
Which fields do you want on your report?
é/ || You can choose from more than one table or guery.
Tables/Queries
Table: STUDENTS a0
Available Fields: Selected Fields:
Student Number == Date of Birth |:|
—— Address R |
== Suburb
——' Postcode
—) State
L_ Phone
<< | Gender @
\ &
cancel < Back Mext = Einish

2) Inthe Tables/Queries list, make sure that table: STUDENTS is selected.

3) Click the ZZ button to select all of the fields for use in the form. All of the fields will now be
listed on the right side.

4) Double-click on Student Number and Comment to move them back over to the left as shown
above.

5) Click Next when ready.

Repore Wizard

Do you want to add any grouping
levels? Gender
Last Mame, First Mame, Date of Birth,
. Address, Suburb, Postcode, State,
Last Name ol Phane, Mark
First Name oo |
Date of Birth o |
Address s
Suburb
Postcode i
State P
Prriori
Phone ty
_"
Grouping Options ... Cancel ! < Back | Mext = Einish

6) The next step allows you to choose grouping levels for your report. Double click on Gender to
select that as the grouping field. This means that all of the female students will be grouped
together in the report and all the male students will be grouped together.

7) Click Next to continue.
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Repore Wizard

What sort order and summary information do you want for detail records?

‘fou can sort records by up to four fields, in either
1 ascending or descending order,
RIS
1 | EEEEE I3 Ascending |
2 Fad Ascending |
3 R Ascending
4 ? % Ascending
Summary Options ... |
Cancel < Back Mext = Einish

This step in the wizard allows you to choose how the records in the report will be sorted. There are
also options for adding totals and subtotals to your report.

8) In the first sort box, select Last Name as shown above. You can also select additional fields for
sorting in case there are any records with the same last name.
9) Click the Summary Options button.

[{-Enmmfxﬁmm
What summary values would you like calculated? oK
Field Sum - Avg  Min  Max Eanesh
Mark O Mo na

Show
® Detail and Summary

) Summary Only

[0 Caleulate percent of
total for sums

You can use these options to add totals for any number fields. The only field available here is Mark.

10) Click the box to put a tick under the Avg option as shown above. This will add an average mark

figure to the report.
11) Click OK to return to the wizard.
12) Click Next to move to the next step.
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Forms & Reports

How would you like to lay out your repart?

HHHE HEH

HEEHH

HEEHHEREE
HEEKE HEEH
i N
N N
M N
MM N
M N
WAMEE R
WAMEE R

HEEHR
K
pEbt
pbt
KR
KM
M
e

HHERE
Wl
pothhy
fgtetahd
btetahd
btutahd
bttt
bttt

KEEK
bttt
Lttt
bttt
M
bttt
i
bttt

Layout Qrientation
©) Stepped e s
7 Block (G

Outline 1
g COutline 2
() Align Left 1

sy Align Left 2

& Adjust the field width so all fields fit on
a page.

Cancel

< Back Mext =

13) Click Align Left 2 for the report layout with_ Landscape selected as the orientation and click Next.

What style would you like?

EEEA————
HXKHRHK i
Compact
Corporate
HEKX HEXX E I
WA KKK oy
Soft Gray
.
Title
Label above Detail
Control frem Detail
Cancel < Back Mext = Einish

14) Select a report style and click Next.

15) Enter Students by Gender for the report name and click Finish.

Students by Gender

Gender E =mals

Last Name First Name Date of Birth Address Subur Postcod  State Phone Mark
Andrmws Claiez 01-11-89 322 Walt=r Rd Morlay 6035 WA (08) 9275 1937 38
Dravizs Lavm 050788 14 Helvomen Rd Moty 6062 WA (08) 5276 8251 48
Sandars Jammemz 5 183 Gand Prom. Badford 6062 WA (08) 52755182 a1
Sheppard Larizzz S 14 Chels=a Crt Dianslla 5039 WA 08) 9375 8127 83
Springar Louis2 18-10-35 36 Surey 8t Dianzllz 5039 WA (08) 93759182 72
Stzvens fzmh 10-(4-8% 24 Brown= Av= Yalins 6060 WA (08) 5248 8127 62
Summary for’Gender = Female (6 detail reconds)
Aug 53
Gender sl |
Last Name First Name Date of Birth Address Subur Postcod  State Phone Mark

\ Note

The name of the report will also become the main heading on the report so choose carefully.
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Report Design

Forms & Reports

Several things may appear in the Report Design window. Some may appear to begin with and others
may need to be turned on before they will appear.

[ EfReport

| Report T‘|

_rFormat_1 Data | Event I OmerI Al ]

Field List

Turn on or off with the =
icon or with the Field List
option in the View menu

Toolbox

Turn on or off with the %
icon or with the Toolbox
option in the View menu

Properties Window )
Turn on or off with the Zr
icon or with the Properties

Shows the fields in the table/query
the report is linked to. This can be
used to add more fields to the report
if needed.

This toolbar has icons for the
common Report Design tools. It
usually sits towards the side of the
screen and can be attached to the side
of the screen so it’s not in the way.

This shows properties that can be
modified for the report or for
whichever part of the form is

E_'l’—tmrd SOUrCE STUDENTS =|| option in the View menu currently selected.
Filter On IIIIIIIIIIIIIIIIIIIIIIIIIIIIII Mo
OrderBY. o vuvasansannas
OrderByOn............ Mo
The design window itself has several sections as shown below.
ﬂl-l']'I'2'I'3'I'4'I'5'I'S'I'?'I'S'I'S'I'IU'I'H'I'IZ'I']S'I'14'I'15'I']B'I']?'I']S'I'IS'I

:I # Report Header

“|Students by Gender

1
o I

# Page Header

# Gender Header

- |||cendgr | |G-nder |

1: Carsiteme irstHapre Fhateof Birth eddreds e HHestendd Statp—Prene
& Detail I I I

% Hl.aat.\'a.ine I ||._‘1i.1'5[.\_1+15 I |Hate c:'E!i.ﬂh ||I.—‘.dd1‘ea4l I |Hubu1‘b I I |H at:cdel ||Stat-| ||?1llcne
# Gender Footer

- |="SL||'| mary flor " & 'Gendegr' =" & " " & [Genden] & " ("|& Count(*) & "|" & IIf{Count({)=1,"dgtail reqord","detail rgcords’) & ")"
 Page Footer

% |=_YOW P

_I  Report Footer
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Using Microsoft Access Forms & Reports

Rulers Placed along the top and side of the form to help you position and select objects on
the report.

Report Header  The contents of this section will be displayed at the beginning of the report.

Page Header This section is displayed at the top of each page in the report.

Gender Header  \When you have used a field to group the results, this area includes everything that
will appear before each group.

Detail This is the section of the report that is repeated for each record.

Gender Footer ~ Summary information for each grouped field. In this case, the average for each
gender will be displayed here.

Page Footer Repeated at the bottom of each page. In this case, the current date and page number
are displayed.

Report Footer Displayed at the end of the report and usually contains totals for the report.

Exercise 8. Customising a Report in Report Design

1) With the Students by Gender report still open, click the View icon & to go to Design View.

2) Click on the Text Box icon abl in the toolbox to the left of the screen.

3) Click in the Report Footer area to place the textbox as shown. A textbox will usually have a label
next to it so make sure you don’t click too close to the left.

{ # Report Footer o
i —l

4) When you click, a textbox and a label will be created.

|_~F Report Footer
: TEXtS:f: | | I’Jﬂbcuﬁd = | :_
5) Click in the label (the one that says Text33:). Edit the label so that it says Total Students.

6) Edit the textbox (the one that says unbound) and change it so it says =count([Mark]).

This is a function that will count all of the records using the Mark field. The square brackets are used

because they are necessary for any formula that refers to a field name.

7) If you are still editing the textbox, press [Enter] to exit edit mode. The whole box should be
selected. Move your mouse over the top-left corner of the box. Your mouse pointer will change
to a hand shape as shown. _¥Counfpn] 8

8) Use this corner to drag the textbox towards the right edge of the report.

Normally dragging a textbox will move it’s related label as well. Using this corner will move only

the textbox.

Note When moving and resizing in a report, be careful not to go too close to the edge of the report. The
wizard will make the report just the right width to fit on a page. If you move things beyond the edge,
even by a small amount, your report will become bigger and won't fit on a page. The result is that
when the report is printed is that you may get what appears like blank pages between every page in
the report as the small overflow gets printed.

9) Click the view icon . to preview the changes to the report and see your new total.
10) Close the report and save any changes.
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Exercise 9. Creating a Report from a Query
1) From the Database Window, click the option that says Create report by using wizard.

Reportwizard

Which fields do you want on your report?

/ || You can choose from more than one table or query.

Tables/Queries

CQuery: parameter: students by last name| a0

Query: student listing with age
Query: student marks

Query: summary: student marks
Query: test query

cancel = Bach Mext = | Einish

2) From the Tables/Queries list, select Query: parameter: students by suburb as shown.

3) Click the ZZ_ icon to select all of the fields in the query and then click Next.
4) Click Next again to skip the grouping options.

Reportwizard
What sort order do you want for your records?

‘You can sort records by up to four fields, in either
ascending or descending order.
1 |Last Mame s Ascending |
PR st [z 74 Ascending |
3 ?\ Acscending
a BRI rscending

cancel < Back | Mext = | Einish

5) Choose to sort by Last name and First name as shown and click Next.

6) Leave the report layout as Tabular and click Next.

7) Select a report style and click Next.

8) For the name of the report, enter Students by Suburb and click Finish.

Because the report is based on a parameter query, the parameter criteria prompt will appear.
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r[ﬂEF—ElEIEE-TEUE[IE— ? X

Enter a suburb

[ @ 1 [ cancel|

9) Enter Morley as the suburb and click OK to see the report.
10) Click the View icon &£ to enter Design view.

The Report Header section contains a label with the text Students by Suburb. We will change this in to
a textbox that shows the name of the suburb being displayed in the report results.

11) Click the Students by Suburb label to select it.

I - TR TR N L TR I

H‘ # Report Header
1 = P

12) From the Format menu choose Change To and then Text Box 2" [T tincon celo

as shown to the right. When the label changes to a textbox, ~ LIE==2-14
its contents will change to Unbound, which just means that ., ... oeeouee PRE N o=
we haven’t specified what will appear in the textbox yet. T N T e
13) In the textbox enter the following v Soepto Grid A X
="Student Listing for " & [Suburb] Align »
Size 3
This is a formula that will take the text inside the quotation
marks (including the space after the word for) and then the &
character will join it to the contents of the Suburb Field (since
we are using the query to only show the results for one suburb. ———

Send to Back | | l l

| =Fagk

14) Re-size the textbox to make it wider.

15) Click the view icon & to preview the report.

16) Enter Morley for the suburb again. The modified report header should now include the suburb as
shown below.

Student Listing for Moriey

Last Name First Name Address Suburh Postcode State
Andrews Claire 322 Walter Rd M orley 6059 WA
Chang Paul 89 Wellington Rd arley 6052 WA
Davies Laura 14 Halvorsen Rd Morley Gog2 WA

17) Close the report and save the changes.
18) Double-click the report to test it again with a different suburb (such as Yokine or Bedford).
19) Close the report again when you are done.
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